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Savet. Ravan preseka moZete dinamicki rotivali tako Slo cete postavili kur-
sor na ivicu ravni preseka. Pojavice se ku or _ otcmnje Povucue ga daf
 biste dinamicki rotivali ravan pres‘eka N e =

neni. Tz*n]ega zmbmte Section wl’mpms Otvorice
PropertyManager u ko ‘moete menjati prikaz preseka.

se Section

Vezbe

U ovoj vezbi cete napraviti model prikazan na slici 7-63. Mere modela date su na
slict 7-64.
(Ocekivano vreme: 30 min)

Shika 7-63 Pun model za veibu 1
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Stika 7-64 Kotirani tehnicki crtezi modela za veibu 1

Da biste zavr$ili ovu vezbu, pratite sledece korake:

Napravite osnovni element modela izvlaCenjem pravougaonika dimenzija
69 mm x 45 mm, nacrtanog na desnoj ravni (Right Plane) na dubinu 10 mm
(slika 7-65).

Napravite drugi element izvladenjem skice nacrtane na zadnjoj stranici osnov-
nog elementa (slika 7-66).

Tredi element modela je kruzni element (slika 7-67).

Napravite otvor na zadatoj tacki i kopirajte element u kruzni sablon.
Napravite element otvora na osnovnom elementu (slika 7-68).

Napravite element zaobljenja i dodajte potrebna zaobljenja, prema slikama
7-69 1 7-70.

Napravite element rebra, prema slikamna 7-71 1 7-72.

Pravijenje osnovnog elementa
1. Pokrenite SolidWorks i otvorite nov dokument dela u okviru za dijalog New

SolidWorks Document.

Na modclu sa slike jasno se vidi da je skica za njegov osnovni element nacrtana
na desnoj ravni (Right Plane). Zna¢i, da biste napravili osnowni element, s pa-
noa FeatureManager Design Tree treba da jzaberete Right Plane.
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2. S panoa FeatureManager Design Tree izaberite Right Plane, pa na panou Fea-
tures CommandManager pritisnite dugme Extruded Boss/Base. Otvorice se
okruZenje za skiciranje, a desna ravan bice orijentisana upravno na pogled.

3. Nacrtajte skicu osnovnog elementa modela: pravougaonik dimenzija 69 mm x
45 mm.

4. Dodajte skici potrebne relacije 1 mere. Izadite iz okruzenja za skiciranje.

5. Na brojacu Depth zadajte vrednost 10 mm i zavriite rad na panou Extrude
PropertyManager. Osnovni element modela prikazan je na slici 7-65.

== 1=

Slika 7-65 Osnovni element modela

lzrada drugog elementa modela
I drugi element modela je izvuéen element. Nacrtajte skicu za drugi element
na zadnjoj stranici osnovnog modela i izvucite je do date dubine.

1. Izaberite zadnju stranicu osnovnog elementa za ravan skice i pokrenite alatku
Extruded Boss/Base.

Nacrtajte skicu za drugi element i dodajte joj potrebne relacije i kote.

SEI

. Izadite 17 okruZenja za skiciranje, pa pritisaite dugme Reverse Direction na
panou PropertyManager.

4. Na brojacu Depth zadajte vrednost 38 i zavriite izradu elementa.

Model ce nakon dodavanja drugog elementa izgledati kao na slici 7-66.

. Napomena
E Prui i drugi element mogls biste napraviti i melodom biranjo. kontyra.

Izrada treceg elementa
Tredi element je kruzni izvudeni element, napravljen izvla¢enjem kruzne skice
na obe strane ravni skice. Skica za ovaj elenient nacrtana je na desnoj planar-
noj stranici drugog elementa.
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1. Izaberite desnu planarnu stranicu drugog elementa za ravan skice i pokrenite
alatku Extruded Boss/Base.

2. Nacrtajte skicu alatkom Circle. Dodelite joj potrebne relacije 1 mere.

8. lzadite iz okruZenja za skiciranje i na brojacu Depth s potpanoa Direction 1,
zadajte vrednost 12. Posto skicu treba da izvucete s razlidiim parametrima za
obe strane rawni, treba da otvorite potpano Direction 2. Na potpanou Direc-
tion 2, na brojacu Depth zadajte vrednost 13 1 zavrSite izradu elementa.

Slika 7-67 prikazuje model nakon dodavanja treceg elementa.

Shka 7-66 Drugt element dodat modeln — Slika 7-67 Treci element dodat modelu

lzrada cetvrtog elementa
Cetvrti element modela jeste element otvora. Otvor cete napraviti na desnoj
stranici treceg elementa pomocu opcije Simple Hole. Da bisre tom opcijom
napravili otvor, morate postaviti tacku za poloZaj otvora.

1. Izaberite desnu stranicu tredeg elementa za ravan skice i predite u okruZenje
za skiciranje. Centralna tacka otvora koji cete napraviti pomocu panoa Hole
PropertyManager, bice podudarna s tom skiciranom tackom.

2. Postavite tacku na desnu stranicu kruznog elementa.

3. Zadajte relaciju Concentric izmedu skicirane tacke i kruzne ivice tredeg ele-
menta, pa izadite iz okruZenja za skiciranje.

4. Izaberite stranicu na koju cete postaviti tacku. Na panou Features Command-
Manager pritisnite dugme Simple Hole, ili iz glavnog menija odaberite Insert
> Features > Hole > Simple, da biste otvorili Hole PropertyManager.

5. S padajuce liste End Condition odaberite opciju Through All i na brojacu
Hole Diameter zadajte vrednost 16.

6. Izaberite centralnu tacku elementa otvora i prevucite kursor na rauije nacrtanu
skiciranu tacku. Pustite levi taster misa kada kursor prione uz skiciranu tacku.

7. Pritisnite dugme OK na panou Hole PropertyManager.
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lzrada petog elementa
1. Postupkom opisanim u prethodnom odeljku, napravite peti element ~ otvor
postavljen na istu ravan. Element otvora je napravijen opcijom Through All,
a precnik mu je 4. Definisite polozaj elementa dodavanjem potrebnih relacija
1 kota.

Sablonsko kopiranje elementa otvora
Posto napravite peti element, iskoristicete ga za izradu kruznog $ablona po-
mocu alatke Circular Pattern.

1. U slu¢aju da ne vidite svu dugmad na panou CommandManager,
pritisnite crnu strelicu i pojavice se podmeni. Na njemu pritisnite
dugme Circular Pattern.

Otvorice se Circular Pattern PropertyManager i program de trazit da izabe-
rete ivicu ili osu koja ce biti referenca pravca. Izaberite stranicu elementa za
§ablonske elemente.

Da biste napravili kruZni §ablon, treba vam ivica ili osa koja e se koristiti kao
centralna osa. Kada pravite kruZni element, automatski nastaje privremena
osa koja prolazi kroz centar elementa. U ovoj vezbi, element koji ce se pona-
vljati u Sablonu napravljen je na kruznom elementu. Znadi, moZete da prikaze-
te privremenu osu kruznog elementa i iskoristite je za centralnu osu.

o

Iz glavnog menija odaberite View > Temporary Axes da biste prikazali privre-

menu osu.

Pojavice se privremene ose na modelu.

3. Izaberite privremenu osu koja prolazi kroz centar prvog elementa otvora.
Pojavice se obladic Direction 1 povezan sa izabranom osom.

4. Pritisnite unutar polja Features to Pattern da biste akgvirali reZim biranja
elemenata.

5. Izaberite manji otvor u oblasti za crtanje, ili proSijrite stablo na panou Featu-
reManager Design Tree prikazanom u oblasti za crtanje i izaberite element
Hole2.

Pojavice se prikaz Sablonskog elementa s podrazumevanim parametrima.

6. Potvrdite polje Equal spacing i na brojacu Number of Instances zadajte
vrednost 6. Pritisnite dugme OK na panou PropertyManager.

7. Odaberite View > Temporary Axes da biste sakrili privremene ose.

Izrada sedmog elementa
1. Sedmi element modela je element otvora. Napravite ga na isti nacin kao i
cewvrti clement. Novi otvor postavite na desnu planarnu stranicu osnovnog
elementa. Potom definidite njegov poloZaj zadavanjem potrebnih relacija i ko-
ta. Slika 7-68 prikazuje model nakon dodavanja elemenata otvora.
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Slika 7-68 Model nakon dodavanja svih otvora

Izrada elementa zaobljenja

Treba da napravite i element zaobljenja. Na slici modela vidite da zaobljenja
koja cete mu dodati imaju razli¢ite polupreénike. U SolidWorksu, u okviru
jednog elementa zaobljenja pojedina¢nim izabranim ivicama, stranicama il
petljama moZete zadati razli¢ite polupreénike zaobljenja.

. Pritisnite dugme Fillet na panou Features CommandManager da biste otvo-

rili Fillet PropertyManager.
Program ce traziti da izaberete ivice, stranice, elemente ili petlje koje ce biti
zaobljene.

. Potvrdite polje Multiple radius fillet na potpanou Items To Fillet panoa Fil-

let PropertyManager.

. Izaberite ivice za zaobljavanje prikazane na slici 7-69. Posto je polje Multiple

radius fillet potvrdeno, svaka izabrana ivica imace svoj oblacic Radius.

. Izmenite vrednost poluprec¢nika preko odgovarajucih oblacica.
. Pritisnite dugme OK na panou Fillet PropertyManager.

Izometrijski prikaz modela nakon dodavanja zaobljenja vidi se na slici 7-70.

lzrada elementa rebra

o

Slededi element koji treba da napravite jeste element rebra. Skica elementa re-
bra treba da bude nacrtana na ravni skice odmaknutoj od zadnje planarne
stranice modela. Zbog toga prvo treba da napravite tu referentnu ravan.

. Otvorite Plane PropertyManager.

Rotirajte model i izaberite njegovu zadnju planarnu stranicu. Potvrdite polje
Reverse direction ispod brojac¢a Distance, a na brojacu zadajte vrednost 19.

. Pritisnite dugme OK na panou Plane PropertyManager da biste napravili

element.
Nova ravan je napravijena na zadatom rastojanju od zadnje planarne stranice
modela,
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|zaberite ove ivice

Shika 7-69 Ivice koje ce biti izabrane Stika 7-70 Model nakon xaobljavanja

4. Pritisnite dugme Rib na panou Features CommandManager.
5. Nacrtajte skicu rebra na novonapravljenoj ravni i zadajte potrebne relacije i
mere, kao na slici 7-71.

=

10

Stika 7-71 Kotiran criez elementa rebra

6. Izadite iz okruZenja za skiciranje. Otvorice se Rib PropertyManager.

U oblasti za crtanje pojavice se prikaz elementa rebra i videcete da je smer do-
davanja materijala prikazan strelicom. Smer dodavanja materijala je suprotan
od onog koji vam treba, pa morate da ga obrnete.

7. Pouvrdite polje Flip material side da biste obrnuli smer dodavanja materijala.
Podrazumevana vrednost za debljinu rebra je 10, a upravo to je vrednost koja
vam treba, pa ne morate da je menjate.

8. Pritisnite OK na panou Rib PropertyManager. Sakrijte novonapravljenu ravan.
Poslednji element modela jeste element zaobljenja. Zaoblite levu ivicu rebra
alatkom Fillet. Na slici 7-72 vidi se izometrijski prikaz gotovog modela.
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Shika 7-72  Gotov puni model

Snimanje modela
1. Napravite poddirektorijum p07 u direktorijumu SolidWorks t pritisnite dugme
Save na paleti alatki Standard. Snimite model pod sledecim imenom:
\My Documents\Solid Works\pO7\pO7vezl sldprt
2. Tz glavnog menija odaberite File > Close da biste zatvorili dokument.

U ovoj vezbi dete napraviti model prikazan na slici 7-73. Mere modela date su na
slici 7-74.
(Océekivano vreme: 30 min)

Slika 7-73 Model za veibu 2
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Slika 7-74 Prikaz spreda i uporedni prikaz preseka s merama

Da biste zavrs$ili ovu vezbu, pratite sledece korake:

a. Napravite osnovni element modela obrtanjem skice duZ ose simetrije, prema
slikama 7-75 1 7-76.

b. Napravite drugi element na spoljnom obimu osnovnog elementa, izviacenjem
skice od ravni skice do izabrane povrsine, prema slikama 7-77 i 7-78.

c. Postavite element ravno upudtenog otvora na gornju stranicu drugog elemen-
ta koristeci Carobnjaka za otvore.

d. Alatkom Circular Pattern napravite §ablon u kom ce se drugi i treci element
ponavljati duZ privremene ose (slika 7-79).

e. Napravite element rebra (slika 7-80).

f. Alatkom Circular Pattern napravite §ablon kojim cete element rebra kopirati
duz privremene ose (slika 7-81).

Izrada osnovnog elementa

Otvorite nov dokument dela. Prvo treba da napravite osnovni element mode-
la obrtanjem skice duZ ose obrtanja. Osa obrtanja ce biti osa simetrije, a skica
za osnovni element bice nacrtana na desnoj ravni (Right Plane).

1. Pokrenite alatku Revolved Boss/Base i izaberite desnu ravan za ravan skice.

2. Nacrtajte skicu osnovnog elementa i zadajte potrebne relacije i kote, kao na
slici 7-75.

3. lzadite iz okruZenja za skiciranje i na brojac¢u Angle zadajte vrednost 360.

4. Pritisnite dugme OK na panou Revolve PropertyManager. Osnovni element
napravljen obrtanjem skice prikazan je na slici 7-76.
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Slika 7-76 Osnovni element modela

lzrada drugog elementa
Drugi element je napravljen jzvla¢enjem skice naviSe do izabrane povriine.

1. Aktivirajte alatku Extruded Boss/Base i izaberite stranicu prikazanu na slici
7-77 za ravan skice.

2. Nacrtajte skicu drugog elementa i zadajte potrebne relacije i kote.

3. Izadite iz okruZenja za skiciranje. Iskoristite opciju Up To Surface pri izvla-
denju skice. Povrsina koju cete izabrati za zavrietak izvlacenja, prikazana je na
slici 7-78.

4. Pritisnite dugme OK na panou Extrude PropertyManager.
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— lzaberite ovu povrsinu

Izaberite
ovu stranicu

Slika 7-77 Stranica koja ce biti izabrana Slika 7-78 Pouvrsina koja ce biti izabrana

Izrada elementa otvora

Na slici 7-74 vidi se da modelu treba dodati ravno upusten otvor, a za to Cete
iskoristiti alatku Hole Wizard. Pre nego $to je pokrenete, izaberite ravan na
koju cete postaviti element otvora.

1. Izaberite gornju stranicu drugog elementa kao ravan za postavljanje elementa
otvora.

2. Pritisnite dugme Hole Wizard na panou Features CommandManager da bi-
ste otvorili okvir za dijalog Hole Definition.
U oblasti za crtanje pojavice se prikaz elementa otvora s podrazumevanim
vrednostima parametara u okviru za dijalog Hole Definition.

3. Izaberite karticu Counterbore, pa s padajuce liste Standard odaberite opciju
Ansi Metric da biste zadali standard koji e biti kori§éen.

4. S liste Screw Type izaberite opciju Socket Button Head Cap Screw - ANSI
B18.3.4M da biste zadali vrstu vijka.

5. S padajuce liste Size izaberite opciju M3 da biste zadali velic¢inu pri¢vricivaca
za koji pravite otvor. Ostavite podrazumevane opcije i pritisnite dugme Next
u okviru za dijalog Hole Definition.
Otvorice se okvir za dijalog Hole Placement.

6. Otvorite Add Relations PropertyManager i zadajte relaciju Concentric izmedu
centralne tacke elementa otvora i kruzne ivice drugog elementa.

7. U okviru za dijalog Hole Placement pritisnite dugme Finish da biste napravili
element.

Izrada Sablona
Poito napravite drugi i treci element, treba da ih kopirate oko privremene ose
pomocu alatke Circular Pattern.

1. Priusnite dugme Circular Pattern na panou Features Command-
Manager da biste otvorili Circular Pattern PropertyManager.

Treba da definiSete osu koja ce predstavljati referencu pravca za
izradu kruinog $ablona. PrikaZite privremene ose tako §to cete iz
glavnog menija izabrati View > Temporary Axes.
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2. Izaberite privremenu osu koja prolazi kroz centar modela i aktivirajte rezim
biranja tako §to cete pritisnuti unutar polja Features to Pattern. Pojavice se
obladic¢ Direction 1.

3. Izaberite drugi i treci element u oblasti za crtanje ili na panou FeatureMana-
ger Design Tree koji je prikazan u oblasti za crtanje.

4. Na broja¢u Number of Instances zadajte vrednost 3 i proverite da li je polje
Equal spacing potvrdeno. Pritisnite dugme OK na panou Circular Pattern
PropertyManager.

5. Sakrijte privremene ose. Model ce nakon izrade Sablona izgledati kao onaj sa
slike 7-79.

Izrada elementa rebra
Slededi element je rebro. Skica elementa rebra bice nacrtana na prednjoj rav-
ni (Front Plane).

1. Na panou Features CommandManager pritisnite dugme Rib i izaberite Front
Plane s panoa FeatureManager Design Tree.

2. Prikaz modela podesite na Wireframe, nacrtajte skicu elementa rebra i zadajte
potrebne relacije, kao na slici 7-80.

| [ T
| I | |
Stika 7-79 Model nakon izrade Sublona Shka 7-80 Skica elementa rebra

od elemenata

3. Izadite iz okruzenja za skiciranje i na broja¢u Rib Thickness zadajte vrednost 2.
Ostalim opcijama ostavite podrazumevane vrednosti i pritisnite dugme OK na
panou Rib PropertyManager.

4. Otvorite osenceni prikaz modela.

5. Alatkom Circular Pattern napravite Scst instanci elementa rebra. Gotov mo-
del nakon izrade svih elemenata, prikazan je na slici 7-81.

Snimanje modela
1. Pritisnite dugme Save na paleti alatki Standard i snimite dokument u direkto-
rijum p07 pod sledecim imenom:
\My Documents\SolidWorks\pO7\pO7vez2.sldprt
2. 1z glavnog menija odaberite File > Close da biste zatvorili dokument.




382 SolidWorks 2006

Slika 7-81 Gotov pun model

U ovoj vezbi cete napraviti glavu cilindra za dvotaktni motor automobila, prikaza-
nu na slici 7-82. Mere modela date su na slici 7-83. Napravicete i prikaz preseka po-

mocu alatke Section View.
(Ocekivano vreme: 1 sat)

Shka 7-82 Model za veibu 3
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Slika 7-83 Prikaz odozgo i prikaz preseha s merama

Da biste zavrdili ovu vezbu, pratite sledece korake:

Napravite osnovni element modela izvla¢enjem poligona do zadate dubine,
prema slici 7-84.

Zaoblite osnovni element.

Napravite kruzni element na donjoj stranici osnovnog elementa.

Dodajte obrtni iseceni element da biste napravili kupolu za glavu cilindra, pre-
ma slikama 7-85 i 7-86.

Izvlacenjem skice napravite levo rashladno rebro glave cilindra. Skicu za taj
element pazljivo kotirajte i definisite prema slici 7-87.

Iskoristite opciju Vary sketch da biste od rebra napravili $ablon (slika 7-88).
Napravite ostale iseCene i izvucene elemente da biste zavrili model (slika 7-89).
Napravite otvor s navojem pomocu ¢arobnjaka za otvore (slika 7-90).
Napravite prikaz preseka modela prema slici 7-91.
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lzrada osnovnog elementa

1. Otvorite nov SolidWorksov dokument dela.
Osnovni element modela bi¢e napravljen izvlacenjem skice nacrtane na gor-
njoj ravni.

2. Pokrenite alatku Extruded Boss/Base i izaberite gornju ravan (Top Plane) za
ravan skice.

3. Nacrtajte skicu osnovnog elementa i zadajte potrebne relacije i mere, kao §to
je prikazano na slici 7-84.

4. Izadite iz okruZenja za skiciranje i izvucite skicu do dubine 4 mm.

126

40

126

60

112 |

Shika 7-84 Skica osnovnog elementa

lzrada drugog elementa
Drugi element modela je zaobljenje. Treba da zaoblite sve vertikalne ivice
osnovnog elementa za dati poluprecnik.
1. Pokrenite alatku Fillet i na brojaéu Radius zadajte vrednost 15. [zaberite sve
vertikalne ivice osnovnog elementa da biste dodali element zaobljenja.
2. Pritisnite dugme OK na panou Fillet PropertyManager.

Pravljenje tankozidnog elementa
Posto napravite osnovu i dodate zaobljenje njenim vertikalnim ivicama, napra-
videte tred element modela - kruzni izvuéeni element. Skicu elementa cete
nacrtati na donjoj stranici osnovnog elementa i izvudi cete je na zadatu dubinu.

1. Pokrenite alatku Extruded Boss/Base i izaberite donju stranicu osnovnog ele-
menia za ravan skice.

2. Nacrtajte krug precnika 55 mm s centrom u koordinatnom pocetku.

3. lzadite iz okruzenja za skiciranje i izvucite skicu do dubine 4 mm.
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Izrada cetvrtog elementa
Ceuvrti element je obrtni iseceni element €jja je skica nacrtana na prednjoj rav-
ni (Front Plane). Posto nacrtate skicu, zadajte potrebne relacije i kotirajte je.

1. Pokrenite alatku Revolved Cut i izaberite Front Plane s panoa FeatureMana-
ger Design Tree.

2. Nacrtajte skicu za obrtni iseceni element i dodelite potrebne relacije i kote,
kao na slici 7-85. Izmedu centralne ta¢ke ldka i koordinawnog pocetka treba da
zadate relaciju Vertical da biste potpuno definisali skicu.

[ I o/ 1]

/

Stika 7-85 Skica obrinog iselenog dela

Napomena

Kada nacrtate skicu za obrtni isecent element, nacrlajte horizontalnu osu sime-
trije tako da njena pocetna tacka bude spojena s gornjom zavrSnom tackom lika.
Pored toga, zadajte relaciju Tangent izmedu Wika i ose simetrije da bi se oCuvala
tangencijalnost hika.

3. Izaberite vertikalnu osu simetrije i izadite iz okruZenja za skiciranje. Na bro-
Jjacu Angle zadajte vrednost 360.

4. Pritisnite dugme OK na panou Cut-Revolve PropertyManager.
Rotiran model, nakon izrade cetvrtog elementa, prikazan je na slici 7-86.

Izrada petog elementa
Napravicete levo rashladno rebro glave cilindra tako Sto éete skicu izvuci u oba
smera i odabrati opciju Through All. Skica elementa, nacrtana na prednjoj
ravni, bice kotirana j definisana tako da duzina rebra zavisi od konstrukcionog
ltika i horizontalne kote. Sledi detaljan opis postupka crtanja, kotiranja i defi-
nisanja skice.
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Stiha 7-86 Iseieni obrtni element dodat modelu

. Pokrenite alatku Extruded Boss/Base i na panou FeatureManager Design

Tree izaberite Front Plane.

. Alatkom Line nacrtajte trougao, a potom nacrtajte vertikalnu osu simetrije

koja prolazi kroz gornje teme trougla (slika 7-87).

. Pokrenite alatku 3 Pt Arc i nacrtajte tak kao $to je prikazano na slici 7-87. Iza-

berite IGk i potvrdite polje For Construction na potpanou Options panoa Arc
PropertyManager.

. Otvorite Add Relations PropertyManager i dodajte relaciju Coincident

izmedu gornjeg temena trougla i ose simetrije.

. Dodajte relaciju Midpoint izmedu donje krajnje tacke ose simetrije i horizon-

talne linije trougla. Proverite da li postoji relacija Coincident izmedu gornjeg
temena trougla i ose simetrije. Dodajte i relaciju Vertical osi simetrije, ukoliko
je nema.

. Dodajte relaciju Goincident izmedu gornjeg temena trougla i liika.
. Dodajte potrebne mere i relacjje da biste potpuno definisali skicu, kao na slici

7-87.

. Izadite iz okruZenja za skiciranpje i izvucite skicu u oba smera koristeci pri tom

opciju Through All. Videcete da se rebro produZava preko osnovnog elemen-
ta na oba kraja. Kasnije u ovoj veibi, naucicete kako da uklonite neZeljeni ma-
terijal rebra.

Savet. Sa slike 7-87 vidi se da jedna horizontalna kota ima t
6.155. Preciznost pnmmzh ]edmz a je podmzumwimb podeser
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Rlis

Slika 7-87 Skica rashladnog rebra za glavu cilindra

Izrada sablona od petog elementa
Koristedi opciju Vary Sketch alatke Linear Pattern, napravicete $ablon za po-
navljanje rashladnih rebara. Zahvaljujuci opciji Vary sketch, geometrija svake
instance u $ablonu menjace se u skladu s kotom koja upravlja §ablonom, i re-
lacijom koja je dodata skici elementa od kog se pravi §ablon.

1. Pritisnite dugme Linear Patterm na panou Features Command-
Manager da biste otvorili Linear Pattern PropertyManager.

Program de traziti da izaberete referencu pravca.

2. Peti clement je podrazumevano izabran u polju Features to Pattern, a '1ko ni-
je, izaberite ga u oblasti za crtanje.

3. U polju Pattern Direction potpanoa Direction 1 izaberite horizontalnu kotnu
liniju s vrednodcu 6.155 za referencu pravca.

4. Na brojacu Spacing zadajte vrednost 9. Na brojac¢u Number of Instances
zadajte vrednost 13. Pritisnite dugine Reverse Direction.

5. Otvorite potpano Options i na njemu potvrdite polje Vary Sketch.
Prikaz $ablona nece se pojaviti u oblasti za crtanje.

6. Pritisnite dugme OK na panou Linear Pattern PropertyManager.
Model, nakon dodavanja $ablonskog elementa, prikazan je na slici 7-88.

lzrada isec¢enog elementa
Sledeci element koji cete napraviti jeste iseceni element. Alatkom Rotate
View rotirajte pun model i primeticete da se rebra koja ste napravili na glavi
cilindra pruzaju preko granica osnovnog elementa. Da biste odsekli deo reba-
ra koji §trci, napravicete ise¢eni element.
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Stika 7-88 Model nakon Sablonskog ponavljanja rebra na glavi cilindra

1. Pokrenite alatku Extruded Cut i izaberite gornju planarnu stranicu osnovnog
elementa za ravan skice.

2. Standardnim alatkama za skiciranje nacrtajte skicu. Skica za ovaj element bice
spoljni profil osnovnog elementa.

Savet. Skicu za koju se horisti spoljni profil osnovnog elementa moZete
nacriali alatkom Convert Entities. Lzaberile donju ravnu stranicu osnov-
nog elementa i pritisnite dugme Convert Entities na paleti Sketch. Prime-
ticete da je skica slicna spoljnoj granici osnovnog elementa postavljena na
ravan skice.

3. Tzadite iz okruZenja za skiciranje, pritisnite dugme Reverse Direction na potpa-
nou Direction 1 i izaberite opciju Through All s padajuce tiste End Condition.
Posto je strana s koje je materijal uklonjen suprotna onoj koja vam treba,
obrnudete smer uklanjanja materijala.

4. Potvrdite polje Flip side to ent na potpanou Direction 1 i pritisnite dugme
OK na panou Cut-Extrude PropertyManager.

5. Standardnim alatkama za modelovanje, oblikujte model kao na slici 7-89.

lzrada Sablona od ostalih elemenata
Kada napravite sve elemente, treba da napravite Sablon od ise¢enog elementa,
izvudenog elementa i elementa otvora u donjem levom uglu modela.

1. Otvorite Linear Pattern PropertyManager 1 izaberite isedeni i izvuceni ele-
ment i otvor u donjem levom uglu modela.

no

Izaberite dve reference smera da biste elemente kopirali u oba smera i zadajte
vrednosti za rastojanja izmedu instanci i za broj instanci (slika 7-83).

8. Pritisnite dugme OK na panou Linear PropertyManager.




Poglavlje 7: Napredne alatke za modelovanje - IT 389

Savet. U SolidWorksu je dostupna i opeija za razmenjivanje skzca: Ona
omogucava da skicu wpotrebljenu ranije iskoristite za izradu elementa
skice. Da biste to ucinili, aktivirajle alatku Features pa izaberite skicu na

panou FeatureManager D Tree. Da biste mogli da izaberete skicu iz

stabla, treba da prosirite stavku na‘prav{;mog skiciranog elementa.

Izrada otvora s navojem
Poslednji element na modelu je element otvora. Alatkom Hole Wizard napra-
videte otvor s navojem, a potom cete definisati njegov poloZaj.

1. Izaberite gornju stranicu srednjeg kruznog izvuéenog clementa za ravan na
koju ce otvor biti postavljen.

2. Otvorite okvir za dijalog Hole Definition tako 3to cete pritisnuti dugme Hole
Wizard na panou Features CommandManager, pa pritisnite jezi¢ak kartice
Tap. S padajude liste Standard jzaberite opciju ANSI Metric.

3. S padajude liste Size izaberite opciju M18x1.5 da biste definisali veli¢inu otvo-
ra s pavojem.

4. Izaberite opciju Through All s padajuce liste Tap Drill Type & Depth, i s
padajuce liste Thread Type & Depth izaberite istu opciju.

5. S padajude liste Add Cosmetic Thread izaberite opciju Add Cosmetic thread
with thread callout. Pritisnite dugme Next u okviru za dijalog Hole Definiti-
on. Otvorice se okvir za dijalog Hole Placement.

Otvor s navojem bice postavljen na podrazumevano mesto na ravni za posta-
vljanje. To mesto nije ono koje vama treba. Definisacete poloZaj otvora s na-
vojem tako da bude koncentric¢an s centrom kruznog elementa.




390 SolidWorks 2006

6. Otvorite Add Relations PropertyManager i zadajte relaciju Concentric iz-
medu centra otvora s navojem i kruznog izvuéenog elementa prec¢nika 55 mm.
7. Pridsnite dugme Finish u okviru za dijalog Hole Placement da biste napravili
OLVOT § navojem.
Rotirani gotov model prikazan je na slici 7-90.

Slika 7-90 Gotov pun model

Prikazivanje preseka modela
Treba da prikazete presek modela. Presek modela ¢ete napraviti pomocu pa-
noa Section View PropertyManager.
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1. OrijentiSite model u izometrijski prikaz.

1o

Pritisnite dugme Section View na panou View CommandManager. |7
Prednja ravan (Front) podrazumevano je izabrana za ravan preseka |
na panou Section View PropertyManager. Prikaz preseka za koji se

prednja ravan koristi kao ravan preseka, pojavice se u oblasti za crtanje.

3. Pritisnite dugme OK na panou Section View PropertyManager da biste
pogledali prikaz preseka modela.

Presek modela je prikazan na slici 7-91.

4. Ponovo pritisnite dugme Section View na panou View CommandManager da
biste se vratili u reZim punog prikaza.

Slika 7-91 Prikaz preseka modela

Snimanje modela
Kada pritisnete dugme Save na paleti alatki Standard, otvorice se okvir za di-
jalog Save As jer dokument dosad nije sniman. U taj okvir za dijalog mozete
uneti ime dokumenta.

1. Pritisnite dugme Save na paleti alatki Standard i snimite model u direkto-
rijum p07 pod sledecim imenom:
\My Documents\SolidWorks\pO7\pO7vez3.sldprt

2. Iz glavnog menija odaberite File > Close da biste zatvorili dokument.






